The smart way to learn Microsoft PowerPoint 2013—one step at a time!
Experience learning made easy—and quickly teach yourself how to create professional-looking presentations with Microsoft PowerPoint 2013. With Step by Step, you set the pace—building and practicing the skills you need, just when you need them!

- Work with PowerPoint on your PC or touch device
- Design, organize, and polish your slides
- Use tables, charts, and graphics to visualize content
- Engage your audience with animation, audio, and video
- Customize themes and templates
- Prepare for your presentation

Your Step by Step digital content includes:
- All the book’s practice files—ready to download at http://aka.ms/PowerPoint2013sbs/files
- Fully searchable ebook. See the instruction page at the back of the book.

Follow the easy numbered steps
- Use screenshots to check your work
- Get helpful tips and pointers
- Build your skills hands-on with ready-made practice files

Microsoft PowerPoint 2013
Build exactly the skills you need. Learn at the pace you want.

Joyce Cox and Joan Lambert

Microsoft Office/Microsoft PowerPoint

Recommended

U.S.A. $29.99
Canada $31.99

Practice files plus ebook
## Contents

**Introduction** .......................................................................................................................... ix
  - Who this book is for ................................................................................................................. ix
  - How this book is organized ..................................................................................................... ix
  - Download the practice files ................................................................................................... x
  - Your companion ebook ......................................................................................................... xiii
  - Get support and give feedback ............................................................................................. xiii
    - Errata ................................................................................................................................. xiii
    - We want to hear from you ................................................................................................. xiv
    - Stay in touch ...................................................................................................................... xiv

**PART 1**

**Basic presentations**

<table>
<thead>
<tr>
<th>1</th>
<th>Explore Microsoft PowerPoint 2013</th>
<th>3</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Identifying new features of PowerPoint 2013</td>
<td>6</td>
</tr>
<tr>
<td></td>
<td>If you are upgrading from PowerPoint 2010</td>
<td>6</td>
</tr>
<tr>
<td></td>
<td>If you are upgrading from PowerPoint 2007</td>
<td>7</td>
</tr>
<tr>
<td></td>
<td>If you are upgrading from PowerPoint 2003</td>
<td>9</td>
</tr>
<tr>
<td></td>
<td>Working in the PowerPoint 2013 user interface</td>
<td>10</td>
</tr>
<tr>
<td></td>
<td>Identifying program window elements</td>
<td>11</td>
</tr>
<tr>
<td></td>
<td><em>Sidebar</em>: About buttons and arrows</td>
<td>13</td>
</tr>
<tr>
<td></td>
<td>Working with the ribbon</td>
<td>16</td>
</tr>
<tr>
<td></td>
<td><em>Sidebar</em>: Adapting exercise steps</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>Opening, navigating, and closing presentations</td>
<td>28</td>
</tr>
<tr>
<td></td>
<td>Viewing presentations in different ways</td>
<td>33</td>
</tr>
<tr>
<td></td>
<td>Searching for help with PowerPoint 2013</td>
<td>40</td>
</tr>
<tr>
<td></td>
<td>Key points</td>
<td>43</td>
</tr>
</tbody>
</table>
2 Create presentations 45

Starting and saving presentations ..................................................... 46
  Sidebar: Compatibility with earlier versions ................................ 54
  Sidebar: Saving files to SkyDrive ................................................. 55
Entering text in placeholders .............................................................. 56
Editing text ....................................................................................... 60
  Sidebar: About the Clipboard ......................................................... 64
Adding and deleting slides ................................................................. 65
  Sidebar: Exporting presentation outlines ....................................... 68
Importing slides from existing sources ............................................. 69
Key points ......................................................................................... 73

3 Work with slides 75

Dividing presentations into sections ............................................... 76
Rearranging slides and sections ....................................................... 80
Applying themes ............................................................................. 84
Changing the slide background ........................................................ 87
  Sidebar: Non-theme colors ............................................................ 94
Formatting text placeholders ............................................................ 96
Key points ......................................................................................... 101

4 Work with slide text 103

Changing the alignment, spacing, size, and look of text ...................... 104
Correcting and sizing text while entering it ........................................ 111
Checking spelling and choosing the best wording ............................... 118
  Sidebar: Researching information and translating text .................. 125
Finding and replacing text and fonts ............................................... 126
Adding text boxes ........................................................................... 129
  Sidebar: Changing the default formatting for text boxes .............. 136
Key points ......................................................................................... 137
5  Add simple visual enhancements  139

Inserting pictures and clip art images.  ................................................................. 140
  Sidebar: Graphic formats  .................................................................................. 146
Creating diagrams  ................................................................................................... 147
  Sidebar: Converting existing bullet points into diagrams  ....................... 154
Plotting charts  ........................................................................................................ 154
Drawing shapes  ........................................................................................................ 162
  Sidebar: Connecting shapes  ............................................................................... 169
Adding transitions  .................................................................................................. 171
Key points  ............................................................................................................... 175

6  Review and deliver presentations  177

Setting up presentations for delivery  ................................................................. 178
Previewing and printing presentations  ............................................................... 184
Preparing speaker notes and handouts  ............................................................ 189
  Sidebar: Enhanced handouts  ............................................................................ 196
  Sidebar: Easy note-taking  ................................................................................ 197
Finalizing presentations  ........................................................................................ 197
  Sidebar: Setting up Presenter view  .................................................................. 204
Delivering presentations  ....................................................................................... 204
Key points  ............................................................................................................... 209

PART 2

Presentation enhancements

7  Present content in tables  213

Inserting tables  ....................................................................................................... 213
Formatting tables  ..................................................................................................... 218
Embedding and updating Excel worksheets  ....................................................... 221
Key points  ............................................................................................................... 227
8 Fine-tune visual elements 229

Editing pictures ................................................................. 229
Sidebar: Alt text .................................................................. 238
Customizing diagrams ......................................................... 238
Formatting charts ................................................................. 244
Sidebar: Pie charts ............................................................... 255
Arranging graphics ............................................................... 255
Key points .......................................................................... 261

9 Add other enhancements 263

Adding WordArt text .......................................................... 264
Inserting symbols and equations ........................................ 267
Capturing screen clippings .................................................. 274
Creating hyperlinks ............................................................. 276
Sidebar: Adding the same hyperlink to every slide ............... 280
Attaching actions to text or objects ...................................... 281
Key points .......................................................................... 285

10 Add animations, audio, and videos 287

Animating with ready-made effects .................................... 288
Customizing animation effects .......................................... 292
Adding audio content ......................................................... 299
Inserting and playing videos ................................................. 303
Key points .......................................................................... 311
# PART 3

## Additional techniques

### 11 Share and review presentations

- Sharing presentations in other formats ...................................................... 316
- Sending presentations directly from PowerPoint ........................................ 326
  - *Sidebar*: Presenting presentations online ........................................... 329
- Protecting presentations by using passwords .............................................. 330
- Adding and reviewing comments ............................................................... 332
- Merging presentation versions ................................................................. 336
- Collaborating with other people ............................................................... 340
- Key points ................................................................................................. 341

### 12 Create custom presentation elements

- Viewing and changing slide masters .......................................................... 344
- Creating themes, theme colors, and theme fonts ........................................ 353
- Designing slide layouts ............................................................................. 362
- Saving custom design templates ............................................................... 369
- Key points ................................................................................................. 373

### 13 Prepare for delivery

- Adapting presentations for different audiences .......................................... 376
- Rehearsing presentations ........................................................................... 380
  - *Sidebar*: Recording presentations ......................................................... 384
- Preparing presentations for travel ............................................................. 386
- Key points ................................................................................................. 389
14 Work in PowerPoint more efficiently

Changing default program options ................................................................. 391
  Sidebar: Using add-ins ........................................................................... 402
Customizing the ribbon ................................................................. 403
Manipulating the Quick Access Toolbar .................................................... 410
  Sidebar: Customizing the status bar ..................................................... 414
Key points ........................................................................................... 414

Glossary ................................................................................................. 415

Keyboard shortcuts ..................................................................................... 423
  PowerPoint 2013 keyboard shortcuts .................................................... 423
    Move between panes ........................................................................ 423
    Work in an outline .......................................................................... 423
    Work with shapes, objects, and WordArt ...................................... 424
    Select text and objects .................................................................. 424
    Delete and copy text and objects ....................................................... 425
    Move around in text ....................................................................... 425
    Move around in and work on tables ................................................ 426
    Edit a linked or embedded object ...................................................... 426
    Format and align characters and paragraphs ................................... 426
    Manage a presentation ..................................................................... 428
  Office 2013 keyboard shortcuts ............................................................ 431
    Display and use windows ................................................................ 431
    Use dialog boxes ............................................................................ 431
    Use the Backstage view .................................................................. 433
    Navigate the ribbon ....................................................................... 433
    Change the keyboard focus without using the mouse ...................... 433
    Undo and redo actions .................................................................... 434
    Change or resize the font ................................................................ 434
    Move around in text or cells ............................................................. 435
    Move around in and work in tables .................................................. 435
    Access and use panes and galleries .................................................. 435
    Access and use available actions ....................................................... 436
    Find and replace content .................................................................. 436
    Use the Help window ....................................................................... 436
Index ................................................................. 439
About the authors .................................................. 461
How to download your ebook ...................................... 463
Survey page ............................................................ 464
Introduction

Part of the Microsoft Office 2013 suite of programs, Microsoft PowerPoint 2013 is a full-featured presentation program that helps you quickly and efficiently develop dynamic, professional-looking presentations and then deliver them to an audience. Microsoft PowerPoint 2013 Step by Step offers a comprehensive look at the features of PowerPoint that most people will use most frequently.

Who this book is for

Microsoft PowerPoint 2013 Step by Step and other books in the Step by Step series are designed for beginning-level to intermediate-level computer users. Examples shown in the book generally pertain to small and medium businesses but teach skills that can be used in organizations of any size. Whether you are already comfortable working in PowerPoint and want to learn about new features in PowerPoint 2013 or are new to PowerPoint, this book provides invaluable hands-on experience so that you can create, modify, and deliver professional presentations with ease.

How this book is organized

This book is divided into three parts. Part 1 explores the everyday experience of working in PowerPoint 2013. Part 2 discusses ways of enhancing presentation content. Part 3 covers more advanced PowerPoint techniques, in addition to customizing program functionality to fit the way you work. This three-part structure allows readers who are new to the program to acquire basic skills and then build on them, whereas readers who are comfortable with PowerPoint 2013 basics can focus on material that is of the most interest to them.

Chapter 1 contains introductory information that will primarily be of interest to readers who are new to PowerPoint or are upgrading from PowerPoint 2003 or an earlier version. If you have worked with a more recent version of PowerPoint, you might want to skip directly to Chapter 2.
This book has been designed to lead you step by step through all the tasks you’re most likely to want to perform with PowerPoint 2013. If you start at the beginning and work your way through all the exercises, you will gain enough proficiency to be able to create and work with most types of PowerPoint presentations. However, with the exception of the topics in Chapter 1, which build on each other, the topics are self-contained, so you can jump in anywhere to acquire exactly the skills you need.

Download the practice files

Before you can complete the exercises in this book, you need to download the book’s practice files to your computer. These practice files can be downloaded from the following page:

http://aka.ms/PowerPoint2013sbs/files

**IMPORTANT** The PowerPoint 2013 program is not available from this website. You should purchase and install that program before using this book.

The following table lists the practice files for this book.

<table>
<thead>
<tr>
<th>Chapter</th>
<th>File</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 1: Explore Microsoft PowerPoint 2013</td>
<td>BuyingTrips.pptx</td>
</tr>
<tr>
<td></td>
<td>DesigningColor.pptx</td>
</tr>
<tr>
<td></td>
<td>SalesMeetingA.pptx</td>
</tr>
<tr>
<td></td>
<td>SalesMeetingB.pptx</td>
</tr>
<tr>
<td>Chapter 2: Create presentations</td>
<td>BuyingTravelB.pptx</td>
</tr>
<tr>
<td></td>
<td>ProjectProcess.pptx</td>
</tr>
<tr>
<td></td>
<td>ServiceA.pptx</td>
</tr>
<tr>
<td></td>
<td>ServiceB.pptx</td>
</tr>
<tr>
<td></td>
<td>ServiceOutline.docx</td>
</tr>
<tr>
<td>Chapter 3: Work with slides</td>
<td>CommunityA.pptx</td>
</tr>
<tr>
<td></td>
<td>CommunityB.pptx</td>
</tr>
<tr>
<td></td>
<td>CommunityC.pptx</td>
</tr>
<tr>
<td></td>
<td>CompanyMeeting.pptx</td>
</tr>
<tr>
<td></td>
<td>DesignWithColor.pptx</td>
</tr>
<tr>
<td></td>
<td>LandscapingA.pptx</td>
</tr>
<tr>
<td></td>
<td>LandscapingB.pptx</td>
</tr>
<tr>
<td>Chapter</td>
<td>File</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Chapter 4: Work with slide text            | CommunityServiceA.pptx  
CommunityServiceB.pptx  
CommunityServiceC.pptx  
TripsA.pptx  
TripsB.pptx |
| Chapter 5: Add simple visual enhancements  | Agastache.jpg  
JournalingA.pptx  
JournalingB.pptx  
Penstemon.jpg  
WaterConsumption.xlsx  
WaterLandscapingA.pptx  
WaterLandscapingB.pptx  
WaterLandscapingC.pptx |
| Chapter 6: Review and deliver presentations| Harmony.pptx  
MeetingA.pptx  
MeetingB.pptx  
ServiceProjectsA.pptx  
ServiceProjectsB.pptx  
YinYang.png |
| Chapter 7: Present content in tables       | MayMeeting.pptx  
NewEquipment.xlsx  
WaterSavingA.pptx  
WaterSavingB.pptx |
| Chapter 8: Fine-tune visual elements       | JuneMeeting.pptx  
NativePlant1.jpg through NativePlant8.jpg  
NativePlants.pptx  
NaturalGardening.pptx  
SavingWater.pptx |
| Chapter 9: Add other enhancements          | JulyMeeting.pptx  
NewWaterSaving.pptx  
OrganizationA.pptx  
OrganizationB.pptx  
OrganizationC.pptx  
Procedures.docx |
<table>
<thead>
<tr>
<th>Chapter 10: Add animations, audio, and videos</th>
<th>File</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 10: Add animations, audio, and videos</td>
<td>AGKCottage.pptx</td>
</tr>
<tr>
<td>Chapter 10: Add animations, audio, and videos</td>
<td>Amanda.wma</td>
</tr>
<tr>
<td>Chapter 10: Add animations, audio, and videos</td>
<td>Bird.jpg</td>
</tr>
<tr>
<td>Chapter 10: Add animations, audio, and videos</td>
<td>Butterfly.wmv</td>
</tr>
<tr>
<td>Chapter 10: Add animations, audio, and videos</td>
<td>HealthyEcosystemsA.pptx</td>
</tr>
<tr>
<td>Chapter 10: Add animations, audio, and videos</td>
<td>HealthyEcosystemsB.pptx</td>
</tr>
<tr>
<td>Chapter 10: Add animations, audio, and videos</td>
<td>NaturalGardenA.pptx</td>
</tr>
<tr>
<td>Chapter 10: Add animations, audio, and videos</td>
<td>NaturalGardenB.pptx</td>
</tr>
<tr>
<td>Chapter 10: Add animations, audio, and videos</td>
<td>Wildlife.wmv</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 11: Share and review presentations</th>
<th>File</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 11: Share and review presentations</td>
<td>CottageShowA.pptx</td>
</tr>
<tr>
<td>Chapter 11: Share and review presentations</td>
<td>CottageShowB.pptx</td>
</tr>
<tr>
<td>Chapter 11: Share and review presentations</td>
<td>HomeHarmony.pptx</td>
</tr>
<tr>
<td>Chapter 11: Share and review presentations</td>
<td>MeetingSH.pptx</td>
</tr>
<tr>
<td>Chapter 11: Share and review presentations</td>
<td>MeetingTA.pptx</td>
</tr>
<tr>
<td>Chapter 11: Share and review presentations</td>
<td>MeetingThemeA.pptx</td>
</tr>
<tr>
<td>Chapter 11: Share and review presentations</td>
<td>MeetingThemeB.pptx</td>
</tr>
<tr>
<td>Chapter 11: Share and review presentations</td>
<td>MeetingThemeC.pptx</td>
</tr>
<tr>
<td>Chapter 11: Share and review presentations</td>
<td>Projects.pptx</td>
</tr>
<tr>
<td>Chapter 11: Share and review presentations</td>
<td>WaterUse.pptx</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 12: Create custom presentation elements</th>
<th>File</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 12: Create custom presentation elements</td>
<td>AnnualMeeting.pptx</td>
</tr>
<tr>
<td>Chapter 12: Create custom presentation elements</td>
<td>NativePlant1.jpg through NativePlant3.jpg</td>
</tr>
<tr>
<td>Chapter 12: Create custom presentation elements</td>
<td>NaturalA.pptx</td>
</tr>
<tr>
<td>Chapter 12: Create custom presentation elements</td>
<td>NaturalB.pptx</td>
</tr>
<tr>
<td>Chapter 12: Create custom presentation elements</td>
<td>NaturalC.pptx</td>
</tr>
<tr>
<td>Chapter 12: Create custom presentation elements</td>
<td>PhotoAlbum.pptx</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 13: Prepare for delivery</th>
<th>File</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 13: Prepare for delivery</td>
<td>CommunityProjects.pptx</td>
</tr>
<tr>
<td>Chapter 13: Prepare for delivery</td>
<td>GettingOrganized.pptx</td>
</tr>
<tr>
<td>Chapter 13: Prepare for delivery</td>
<td>Journal.pptx</td>
</tr>
<tr>
<td>Chapter 13: Prepare for delivery</td>
<td>Procedures.docx</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 14: Work in PowerPoint more efficiently</th>
<th>File</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 14: Work in PowerPoint more efficiently</td>
<td>BuyersSeminar.pptx</td>
</tr>
<tr>
<td>Chapter 14: Work in PowerPoint more efficiently</td>
<td>ColorDesign.pptx</td>
</tr>
</tbody>
</table>
If you would like to be able to refer to the completed versions of practice files at a later time, save the modified practice files at the end of each exercise. If you might want to repeat the exercises, either save the modified practice files with a different name or in a different folder.

Your companion ebook

With the ebook edition of this book, you can do the following:

- Search the full text
- Print
- Copy and paste

To download your ebook, please see the instruction page at the back of the book.

Get support and give feedback

The following sections provide information about getting help with this book and contacting us to provide feedback or report errors.

Errata

We’ve made every effort to ensure the accuracy of this book and its companion content. Any errors that have been reported since this book was published are listed on our Microsoft Press site:

http://aka.ms/PowerPoint2013sbs/errata

If you find an error that is not already listed, you can report it to us through the same page.

If you need additional support, email Microsoft Press Book Support at mspinout@microsoft.com.

Please note that product support for Microsoft software is not offered through the addresses above.
We want to hear from you

At Microsoft Press, your satisfaction is our top priority, and your feedback our most valuable asset. Please tell us what you think of this book at:

http://www.microsoft.com/learning/booksurvey

The survey is short, and we read every one of your comments and ideas. Thanks in advance for your input!

Stay in touch

Let’s keep the conversation going! We’re on Twitter at: http://twitter.com/MicrosoftPress.
Chapter at a glance

**Divide**
Divide presentations into sections,
page 76

<table>
<thead>
<tr>
<th>5 Introduction (2 slides)</th>
</tr>
</thead>
<tbody>
<tr>
<td>6 Process (2 slides)</td>
</tr>
<tr>
<td>7 Selling</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>9 Executing</td>
</tr>
<tr>
<td>10</td>
</tr>
<tr>
<td>11</td>
</tr>
</tbody>
</table>

**Apply**
Apply themes,
page 84

**Change**
Change the slide background,
page 87

**Format**
Format text placeholders,
page 96

**Designing with Color**
Wide World Importers
IN THIS CHAPTER, YOU WILL LEARN HOW TO

- Divide presentations into sections.
- Rearrange slides and sections.
- Apply themes.
- Change the slide background.
- Format text placeholders.

When developing a presentation with more than a dozen slides, you can work on subsets of slides by creating sections. Sections are not visible to the audience, but they help you organize your slides logically and format them efficiently. A logical presentation and an overall consistent look, punctuated by variations that add weight exactly where it is needed, can enhance the likelihood that your message will be well received and absorbed by your intended audience.

In this chapter, you’ll divide a presentation into sections and will move sections and individual slides to organize them logically. Then you’ll apply a theme and its variants to the presentation. You’ll also add color and shading to the background of slides and to the background of placeholders.

PRACTICE FILES  To complete the exercises in this chapter, you need the practice files contained in the Chapter03 practice file folder. For more information, see “Download the practice files” in this book’s Introduction.
Dividing presentations into sections

To make it easier to organize and format a longer presentation, you can divide it into sections. In both Normal view and Slide Sorter view, sections are designated by titles above their slides. They do not appear in other views, and they do not create slides or otherwise interrupt the flow of the presentation.

Because you can hide whole sets of slides under their section titles, the sections make it easier to focus on one part of a presentation at a time. If you are working on a presentation with other people, you can name one section for each person to delineate who is responsible for which slides.

**TIP** Some templates include a layout for section divider slides. If you divide a long presentation into sections based on topic, you might want to transfer your section titles to these slides to help guide your audience during presentation delivery.

In this exercise, you’ll divide a presentation into two sections, adding one in Normal view and the other in Slide Sorter view. After naming the sections, you’ll hide their slides and then display first one section and then both sections.

**SET UP** You need the CommunityA presentation located in the Chapter03 practice file folder to complete this exercise. Open the presentation, and then follow the steps.

1. On the Home tab, in the Slides group, click the Section button, and then click Add Section to add an Untitled Section title before slide 1 in the left pane.

   **TROUBLESHOOTING** If PowerPoint selects and displays the last slide, scroll back to the top of the Thumbnails pane and click slide 1.
The Thumbnails pane, with the new section title above the first slide in the section.

2 Switch to Slide Sorter view, and adjust the zoom percentage to display the 13 slides in the presentation.

3 Click slide 4. Then click the Section button, and click Add Section to add an Untitled Section title before slide 4.
PowerPoint starts a new section and selects its slides.

To make the sections more useful, let’s name them.

4 Right-click the second **Untitled Section** title, and click **Rename Section** to open the **Rename Section** dialog box.

![Rename Section dialog box]

*In the Rename Section dialog box, the current name is selected in the Section Name box so that you can easily replace it.*

5 In the **Section name** box, enter **Process**, and then click **Rename**.
Switch to **Normal** view, scroll to the top of the **Thumbnails** pane, and then click the **Untitled Section** title above slide 1 to select the section title and all the slides in the section.

You can select each section of the presentation independently.

Display the **Rename Section** dialog box, enter **Introduction** as the section name, and click **Rename**.
Now let’s use sections to view different parts of a presentation.

8 In the Slides group, click the Section button, and then click Collapse All to hide the slides under their section titles.

You can collapse sections to provide an “outline” of long presentations, with the number of slides in each section displayed in parentheses.

9 In the Thumbnails pane, to the left of Introduction, click the Expand Section arrow to display only the slides in that section.

10 Display all the slides by clicking the Section button in the Slides group and then clicking Expand All.

CLEAN UP Close the CommunityA presentation, saving your changes if you want to.

Rearranging slides and sections

After you have added several slides to a presentation, you might want to rearrange their order so that they effectively communicate your message.

TIP You can copy slides from one open presentation to another in Slide Sorter view. First display both presentations in Slide Sorter view, and on the View tab, in the Window group, click the Arrange All button. Then drag slides to copy them from one presentation window to the other.
You can rearrange a presentation in three ways.

- In the **Thumbnails** pane, drag slides up and down to change their order.
- In the **Thumbnails** pane, move entire sections up or down to rearrange the presentation.
- To display more of the presentation at the same time, switch to **Slide Sorter** view, where you can drag slides or sections into the correct order.

In this exercise, you’ll work in Normal view and in Slide Sorter view to logically arrange the slides in a presentation. You’ll also delete a section you no longer need.

**SET UP**  You need the CommunityB presentation located in the Chapter03 practice file folder to complete this exercise. Open the presentation, and then follow the steps.

1. In the **Thumbnails** pane, click slide 2. Then drag the selected slide downward until it sits between the **Process** section title and slide 4, but don’t release the mouse button yet. Notice as you drag that the other slides move either up or down to indicate where the selected slide will appear when you release the mouse button.

2. Release the mouse button to move the slide to its new location, and notice that PowerPoint renumbers slides 2 and 3.

3. To the left of **Introduction** in the first section title, click the black **Collapse Section** arrow. Then repeat this step for the **Process** section.

   Even with these two sections collapsed, not all the slides in the Thumbnails pane are visible. Let’s move to a view where you can display them all.

4. Switch to **Slide Sorter** view. Then use the **Zoom Slider** at the right end of the status bar to adjust the zoom percentage until all the slides are visible. (We set the zoom percentage to 50 percent.)
The sections you collapsed in Normal view are still collapsed in Slide Sorter view.

5 In the **Selling** section, click slide 7, and then drag it to the left until it sits to the left of slide 5. Notice that PowerPoint renumbers the slides in the section.

Now let’s move a section.

6 Right-click the **Planning** section title, and then click **Move Section Up** to move the **Planning** section and all its slides above the **Selling** section.

7 Switch to **Normal** view, expand all the sections in the presentation, and then select slide 1.

The first two sections could easily be combined into one section, so let’s do that next.
Remove the second section by clicking the **Process** section title, clicking the **Section** button in the **Slides** group, and clicking **Remove Section**.

The Introduction section now contains the first four slides.

**CLEAN UP** Close the CommunityB presentation, saving your changes if you want to.
Applying themes

When you create a presentation based on a template, the presentation includes a theme—a combination of colors, fonts, formatting, graphics, and other elements that gives the presentation a coherent look. Even a presentation based on the Blank Presentation template has a theme; the Office theme is applied by default. This theme consists of a white background, a very basic set of colors, and the Calibri font.

If you want to change the theme applied to a presentation, you can choose one from the Themes gallery on the Design tab. Many themes are accompanied by variants, providing a range of instant choices of background and text color with the same basic design. By using the Live Preview feature, you can easily try different effects until you find the one you want.

SEE ALSO  For information about creating your own themes, see “Creating themes, theme colors, and theme fonts” in Chapter 12, “Create custom presentation elements.”

In this exercise, you’ll first change the theme of a presentation that was created from scratch, using the Blank Presentation template as a starting point. Then you’ll change the theme of a presentation that was based on a content template. Finally, you’ll apply different theme variants to different sections of a presentation.

SET UP  You need the LandscapingA, CompanyMeeting, and CommunityC presentations located in the Chapter03 practice file folder to complete this exercise. Open all three presentations, and then with the LandscapingA presentation active, follow the steps.

1. On slide 1, click the slide’s title. Notice that the slide has a white background with black text in the Calibri font.

2. On the Design tab, in the Themes group, click the gallery’s More button to open a menu that contains the entire Themes gallery.
Applying themes

In turn, point to each theme thumbnail in the Office area of the gallery to display their names in ScreenTips and show a live preview of what the presentation will look like with that theme applied.

Click the Ion thumbnail to apply that theme to the entire presentation. Notice that the slides now have a dark aqua, gradient background with a red accent in the upper-right corner.

With the title still selected, click the Home tab. Notice that the title text is now white and in the Century Gothic font.
Most built-in themes have a distinctive title slide design that is modified for all the other slide layouts.

Now let’s work with a presentation that already has a theme applied to it.

6 On the View tab, in the Window group, click the Switch Windows button, and click CompanyMeeting.

7 Display the Themes gallery, and then click the Slice thumbnail to switch to a design with a bright blue background and text in white and blue Century Gothic.

Good color contrast is important for any presentation, but especially for those that will be delivered on a screen to a roomful of people. Let’s look at the variants of the Slice theme to determine whether any of them have better contrast.

8 On the Design tab, in the Variants group, point to each variant thumbnail in turn to display a live preview of what the presentation will look like with that variant applied.

9 After previewing each variant, click the Orange variant at the right end of the group.

Now let’s use themes in a presentation that has been divided into sections.
On the **View** tab, in the **Window** group, click the **Switch Windows** button, and click **CommunityC**.

Switch to **Slide Sorter** view, and adjust the zoom percentage to display all the slides.

With slide 1 selected, display the **Themes** gallery from the **Design** tab, and then click the **Retrospect** thumbnail to apply that theme to the entire presentation.

Click the **Planning** section title, and in the **Variants** group, click the second variant to apply it to the slides in the **Planning** section.

Click the **Selling** section title, and apply the third variant to the slides in that section.

Click the **Executing** section title, and click the fourth variant, which makes the slides in that section unreadable.

With the **Executing** section title still selected, click the first variant to apply the same theme colors to the slides in the fourth section as those in the first section.

**TIP** If you like the colors of one theme, the fonts of another, and the effects of another, you can mix and match theme elements. First apply the theme that most closely resembles the look you want. Then in the Variants group, click the More button, and change the colors by clicking the Colors button, the fonts by clicking the Fonts button, or the effects by clicking the Effects button. For more information, see “Creating themes, theme colors, and theme fonts” in Chapter 12, “Create custom presentation elements.”

**CLEAN UP** Close the **CommunityC**, **CompanyMeeting**, and **LandscapingA** presentations, saving your changes if you want to.

---

**Changing the slide background**

In PowerPoint, you can customize the background of a slide by adding a solid color, a color gradient, a texture, or even a picture. You make these changes in the Format Background pane, which opens when you click the Format Background button in the Customize group on the Design tab.
In the Format Background pane, you can control the appearance of the color, texture, pattern, or picture applied to the background of the current slide or all slides.

In the Format Background pane, you can click icons to display pages where you can do the following:

- **Fill** Select a solid color, color gradient, picture, texture, or pattern fill, as well as display or hide background graphics and set the color and transparency.

- **Effects** Apply artistic effects to picture or texture fills.

- **Picture** Manipulate the sharpness, brightness, contrast, and color of picture fills.

A color gradient is a visual effect in which a solid color gradually changes from light to dark or dark to light. PowerPoint offers several gradient patterns, each with variations.

If you want something fancier than a solid color or a color gradient, you can give the slide background a texture or pattern. PowerPoint comes with several built-in textures that you can easily apply to the background of slides. If none of these meets your needs, you might want to use a picture of a textured surface. For a dramatic effect, you can even incorporate
a picture of your own, although these are best reserved for small areas of the slide rather than the entire background.

In this exercise, you’ll shade the background of one slide. Then you’ll apply a textured background to all the slides in the presentation.

**SET UP** You need the DesignWithColor presentation located in the Chapter03 practice file folder to complete this exercise. Open the presentation, and then follow the steps.

1. On the **Design** tab, in the **Customize** group, click the **Format Background** button to display the **Format Background** pane on the right side of the screen.

2. With the **Fill** page displayed, click **Gradient fill**.

When you select a background option, the **Format Background** pane changes to show the settings for that option.

3. Adjacent to **Color**, click the **Color** button to display a menu containing two color palettes.
You can select a variation of the colors provided by the current theme or a standard color. Below the palettes are commands for more precise color choices.

4 In the top row of the Theme Colors palette, click the eighth swatch (Purple Accent 4), which instantly changes the background of slide 1 to a purple gradient.

**TIP** To change a theme color throughout a presentation, you need to make the change on the slide master. For information, see “Creating themes, theme colors, and theme fonts” in Chapter 12, “Create custom presentation elements.”

Let’s refine the gradient of this title slide background by changing its shape, direction, and color.

5 In the Format Background pane, click the Type arrow, and then in the list of options, click Rectangular. Notice that on the active slide, the purple gradient changes to reflect this setting.

6 Click the Direction button, and then click the rightmost thumbnail (From Top Left Corner).

7 In the Gradient stops area, click the second handle on the slider (Stop 2 of 4), and to the right, click the Remove gradient stop button. Then drag the middle handle (Stop 2 of 3) to the left until the Position setting is 70%.
The title slide has a two-tone gradient that radiates from the upper-left corner.

**TIP** If you want to proof the text of your slides without the clutter of background graphics, clear the Hide Background Graphics check box on the Fill page of the Format Background pane. If you want to print your slides without their color backgrounds, on the Print page of the Backstage view, select the Grayscale or Pure Black And White option.

Now let’s fill the background of all the slides with a texture.

In the **Format Background** pane, click **Picture or texture fill** to display the settings for that option.
9 Click the **Texture** button to display the **Texture** gallery.

You can select from a variety of available textures, including fabrics, marbles and granites, wood grains, and Formica-like textures in various colors.

10 Click a texture that appeals to you to display slide 1 with that background. Then continue to apply textures, noticing that most of them are too complex, even for a slide with very little text.

11 When you have finished exploring, at the right end of the gallery’s top row, click **Water droplets**.
In the lower-left corner of the Format Background pane, click Apply to All. Then close the pane.

The Water Droplets texture has been applied to the background of all the slides.

TIP If you want to add a watermark, such as the word Draft or Confidential, to the background of your slides, you need to add the text to the background of the slide master. For information about slide masters, see “Viewing and changing slide masters” in Chapter 12, “Create custom presentation elements.”

CLEAN UP Close the DesignWithColor presentation, saving your changes if you want to.
Chapter 3  Work with slides

Non-theme colors

Although using themes enables you to create presentations with a pleasing design impact, you might want to make an element appear in a color that is not part of the theme. You apply these colors by selecting the element whose color you want to change and then choosing a color from the Standard Colors palette of the associated color menu or by choosing a custom color from the wide spectrum available in the Colors dialog box.

To select a color that is neither part of the theme nor a standard color:

1. Display the appropriate color menu; for example, the menu that appears when you click Solid Fill, and then click the Fill Color button in the Format Background pane.
2. At the bottom of the menu, click More Colors to open the Colors dialog box.
3. Click a color in the Colors wheel, and then click OK.

On the Standard page permutations of primary, secondary, and tertiary colors form a hexagonal color wheel.
To define a custom color:

1. Display the Colors dialog box, and then click the Custom tab.

   ![Colors dialog box]

   On the Custom page permutations of primary and secondary colors form a spectrum.

2. Click an approximate color in the Colors spectrum, and then do one of the following:
   - Select the RGB color mode, and then precisely define the Red, Green, and Blue settings.
   - Select the HSL color mode, and then precisely define the Hue, Saturation, and Luminescence settings.

3. Click OK to close the Color dialog box.

   If you want to make a selected element the same color as one that is used elsewhere on the same slide, display the color menu, click Eyedropper, and then click the color you want.

   After you use a non-theme or non-standard color, it becomes available in the Recent Colors palette of all color menus. The color remains on the palette even if you change the theme applied to the presentation.
Format text placeholders

For a consistent look, you won't usually want to change the formatting of a presentation’s text placeholders. However, when you want to draw attention to a slide or one of its elements, you can do so effectively by making specific placeholders stand out.

A text placeholder usually has no border, so when it’s not selected, its text appears to float on the slide. When you click the text once, the placeholder has a dashed border. The placeholder is then selected for editing, and you can enter new text or edit existing text.

When a placeholder has a dashed border, you can enter or edit text.

Clicking the dashed border changes it to a solid border. You can then manipulate the placeholder as a unit; for example, you can size and move it.

When a placeholder has a solid border, you can manipulate the placeholder.

When a placeholder is selected, the Format tool tab appears on the ribbon, because placeholders are actually text-box shapes that can be manipulated like any other shape.
From the Shape Styles group on this tab, you can format a placeholder in the following ways:

- Fill the background with a color, gradient, texture, pattern, or picture.
- Change the color and style of the shape’s outline.
- Apply a style such as a shadow, reflection, or glow.
- Apply a three-dimensional effect.
- Select a predefined shape style that incorporates some or all of the preceding options.

**TIP** Your changes affect only the selected placeholder, not corresponding placeholders on other slides. If you want to make changes to the same placeholder on every slide, make the adjustments on the presentation’s master slide. For more information about working with master slides, see “Viewing and changing slide masters” in Chapter 12, “Create custom presentation elements.”

In this exercise, you’ll first select a placeholder to review the effect on its border. You’ll apply a ready-made style, and then you’ll customize the formatting by changing the fill color, adding a border, and applying a special effect.

**SET UP** You need the LandscapingB presentation located in the Chapter03 practice file folder to complete this exercise. Open the presentation, and then follow the steps.

1. Display slide 3, and click the slide title to select the placeholder for editing, as indicated by the cursor and dashed border.

   **TROUBLESHOOTING** If your placeholder border looks solid, try increasing the zoom percentage until the dashes are visible.

2. Point to the border of the placeholder, and when the pointer changes to a four-headed arrow, click once to select the placeholder for manipulation, as indicated by the solid border.
3 On the **Format** tool tab, in the **Shape Styles** group, click the gallery’s **More** button to display a menu containing the **Shape Style** gallery.

*The Shape Style gallery has 42 predefined options.*

4 Click the fifth thumbnail in the second row (**Colored Fill - Green, Accent 4**) to fill the placeholder with a light aqua color.

Now let’s apply some custom formatting.

5 In the **Shape Styles** group, click the **Shape Fill** button to display a menu containing palettes. Then point to a few color swatches in turn to display a live preview of the effects on the placeholder.

6 Click the fourth swatch in the dark red column (**Dark Red, Accent 1, Darker 25%**) to fill the placeholder with a red that is slightly darker than the accent bar in the upper-right corner.
7 Click the **Shape Fill** button again, and then below the palettes, point to **Gradient** to display a menu containing the **Gradient** gallery.

---

8 In the **Dark Variations** area, click the second thumbnail in the third row (**Linear Up**). Now let’s emphasize the border.

9 In the **Shape Styles** group, click the **Shape Outline** button, and then in the **Theme Colors** palette, click the second swatch in the dark teal column (**Dark Teal, Background 2, Lighter 60%**).

10 Click the **Shape Outline** button again. Then below the palettes, point to **Weight**, and in the list, click **3 pt**.

**TIP** The abbreviation pt stands for *point*. A point is a unit of measurement used in the design and publishing industries. There are 72 points to the inch.
Next let’s add an effect to the placeholder.

11 In the Shape Styles group, click the Shape Effects button to display a gallery of all the types of effects you can apply to the placeholder.

In the Shape Effects gallery, you can select from many possible special effects organized in seven categories: Preset, Shadow, Reflection, Glow, Soft Edges, Bevel, and 3-D Rotation.

12 In turn, display the options for each effect category, and point to a few to display their live previews.

13 When you have finished exploring, point to Glow, and then in the Glow Variations area of the gallery, click the fifth thumbnail in the last row (Teal, 18 pt glow, Accent color 5).

14 Click a blank area of the slide to release the selection so that the effects of your changes to the formatting of the placeholder are more obvious.
You can easily set off placeholders with combinations of color, borders, and effects.

CLEAN UP Close the LandscapingB presentation, saving your changes if you want to.

Key points

- Grouping slides into sections makes it easy to focus on and format specific parts of the presentation.

- If you need to change the order of slides or sections, you can rearrange them in the Thumbnails pane in Normal view, or in Slide Sorter view.

- Switching from one predefined theme or theme variant to another is an easy way to change the look of an entire presentation. Applying different themes or variants to different sections of a presentation is a good way to signal a change in a major topic.

- To dress up the background of one slide or of all the slides in a presentation, you can apply a solid color, color gradient, texture, pattern, or picture.

- You can change the background, outline, and effect of specific placeholders to make them stand out.
Symbols and Numbers

© (copyright symbol), 267
® (registered trademark symbol), 267
Σ (sigma or summation symbol), 268
35mm slides, 178, 179

A
accent theme colors, 353
accepting/rejecting revisions, 337, 338
accessibility
  checking, 199
  of content in text boxes, 129
accessible content, defined, 415
Account page (Backstage), 26
action buttons, 281, 283
defined, 415
Action Settings dialog box, 281
actions, 281
add-ins, 399, 402
defined, 415
adding
  action buttons to slides, 281, 283
  alt text to diagrams, 148
  alt text to graphics, 238
  alt text to pictures, 144
  alt text to text boxes, 131
  animation effects to objects, 288
  annotations to graphics, 129, 143
  audio content to slides, 299, 301
  borders to pictures, 230
  borders to placeholders, 99
  borders to tables, 220
  borders to text boxes, 131, 134
  buttons to Quick Access Toolbar, 411
  charts to slides, 154, 157
  clip art images to slides, 140, 144
  commands to ribbon groups, 406
  comments to slides, 332, 334
  datasheets to charts, 252
  diagrams to slides, 148
  effects to placeholders, 100
  effects to shapes, 163, 167
  effects to text, 131
  effects to text boxes, 131
  elements to charts, 244
  equations to text, 268, 271
  footers to slides, 179, 181
  hyperlinks to every slide, 280
  hyperlinks to slides, 276
  layouts to slide masters, 363
  misspellings to AutoCorrect, 111, 113
  notes to slides, 189, 190
  notes with graphics, 190
  pictures to slides, 140, 141
  pictures to slides without content placeholders, 143
  place holders to slide layouts, 363
  rows/columns to tables, 214, 216
  screen clippings to slides, 274
  shapes to charts, 162
  shapes to diagrams, 239
  shapes to slides, 163
  slide timings, 380
  slides to presentations, 65, 66
  sounds to animation effects, 294, 297
  sounds to transitions, 175
  spoken comments to slides, 385
  symbols to text, 267, 270
  tables to slides, 213, 215
  text boxes to slides, 129, 131, 135, 144
  text to diagrams, 149
  text to shapes, 163, 166
  transitions to slides, 171, 172
  videos to slides, 303
  watermarks to slides, 93
  WordArt text to slides, 264
adjusting shapes, 162
adjustment handles, defined, 415
aligning
  embedded objects, 224
  graphics, 256, 257
  pictures while sizing, 233
aligning (continued)
slide elements, 35
text in placeholders, 104, 109
text in table cells, 217
text in text boxes, 131
alternative words, using Thesaurus to find, 119, 123
alt text, attaching
  to diagrams, 148
to graphics, 238
to pictures, 144
to text boxes, 131
animating
  bullet points, 290, 294
  pictures, 290
  slide titles, 288
animation, defined, 415
animation effects, 288
  adding sounds, 294, 297
  copying, 288, 291
  customizing, 292, 295
  previewing, 290
  refining, 292
  turning off, 184
Animation gallery, 288
Animation Painter, 288, 291, 298
Animation pane, 293
Animations tab, 24
annotations, adding to graphics, 129, 143
appearance of ribbon, 16
arranging
  graphics, 255
  windows, 35, 38
artistic effects for pictures, 230, 236
Artistic Effects gallery, 236
assigning passwords, 330
attaching
  actions, 281
  hyperlinks, 277
attributes
  defined, 415
  applying, 105, 107
audience-specific presentations, 376
audio clips, 299, 301
audio content. See also sounds
  adding to slides, 299
  customizing, 300, 302

440 alternative words, using Thesaurus to find

looping, 300, 302
pausing, 303
playing, 299, 302
playing across slides, 303
testing, 300
trimming, 300
volume, 300
audio files, 299
audio icons, 299
hiding, 300
moving, 301
AutoCorrect
  defined, 415
  customizing, 111, 113
  options, setting, 394
AutoCorrect dialog box, 112, 113
AutoFit, 112, 116
  default settings, 112
automatic updating of pictures, 141
autosave time interval, 49, 395

B
background theme colors, 353
backgrounds, 87, 89
  defined, 415
  hiding, 91
  of pictures, removing, 230, 234
  of user interface, 393
Backstage view, 12, 26
  Account page, 26
  Export page, 196
  Info page, 198, 199
  New page, 26
  Open page, 28
  Print page, 184, 187
  Save As page, 47
  Share page, 326
banded rows in tables, 218
banners, 179, 181
bar charts, 244
Basic animation effects, 292
bitmaps, 146
black and white slides, 35, 185, 187
black last slide, eliminating, 37, 207
black pause screen, 206
blank presentations, new, 46, 49
blocking content, 400
.bmp format, 146
body font in theme fonts, 354
  defined, 415
bold text, 105
borders
  adding to pictures, 230
  adding to placeholders, 99, 163
  adding to tables, 220
  adding to text boxes, 131, 134, 163
  adding to shapes, 163
  of table cells, erasing, 214
breaks, line, 106, 110
broadcasting presentations. See presenting online
building slides with animation, 292
bullet characters
  picture, 349
  removing, 364
bullet points
  defined, 415
  animating, 290, 294
  converting to diagrams, 154
  converting to normal paragraphs, 104, 109
  converting to paragraphs, 364
  converting to subpoints, 58
  converting to titles, 58
  formatting on slide masters, 346, 349
  hiding in Outline pane, 62
  indenting on slide masters, 351
Bullets And Numbering dialog box, 350
Bullets gallery, 109
bullet styles, formatting, 104
buttons, 13
  adding to Quick Access Toolbar, 411
ScreenTips, 13
ScreenTips, hiding, 393

captions in photo albums, 234
  defined, 415
capturing screen clippings, 274
case
  defined, 415
  changing, 106
  finding, 126
category axes in charts, 155
cell addresses, defined, 415
cells, defined, 415
cells (table). See table cells
cells (worksheet), 155, 225
Change Chart Type dialog box, 246
character formatting, 105, 107
  defined, 415
  attributes, 415
  clearing, 106, 109
character spacing, 106
chart area, defined, 415
Chart Filters pane, 160
chart layouts, 244, 250
chart styles, 244, 247
Chart Styles pane, 247
chart types, 244, 246
  custom, deleting , 254
  custom, saving, 245, 253
charts, 154
  defined, 415
  adding elements, 244
  adding to slides, 154, 157
  associated Excel worksheets, 154
category (x) axes, 155
chart types, 244, 246
copying/pasting existing data, 156, 157
data markers, 155
data points, 155
data series, 155
datasheets, 252
data editing, 156, 159
tables, 156
excluded data, 158
filtering data, 160
formatting, 244, 245
gridlines, 249
hiding data, 158
layouts/styles, 244, 247, 250
legends, 155, 250
moving, 156
charts (continued)
plotting by rows/columns, 159
saving as templates, 245, 253
selecting cells, 156
selecting elements, 245, 249
series (z) axes, 155
sizing, 156, 159
tick-mark labels, 155
value (y) axes, 155
Check Accessibility, 199
Check Compatibility, 199
checking spelling
as you type, 119, 120
of entire presentation, 119, 121
Choose A SmartArt Graphic dialog box, 148
circles, drawing, 162
clearing character formatting, 106, 109
clip art audio, 299, 301
clip art images
defined, 415
adding to slides, 140, 144
Clipboard, 61, 64
defined, 415
closing
galleries, 23
PowerPoint, 11
presentations, 30, 32
coauthoring, 6
collaborating, 340
collapsing
outlines, 62
ribbon, 35
color
after animation, 294
Eyedropper, 95, 248
of diagrams, 152
of markup pen/laser pointer, 206, 209
of pictures, 230
of shapes, 163
of shapes in diagrams, 239
of text, 105, 108, 131
of text boxes, 131
transparent, in pictures, 230
color fills, 98
color gradients, 88
defined, 415
color palettes, 353
colors. See non-theme colors; theme colors
Colors dialog box, 94, 359
Colors gallery, 355
color slides, viewing in black and white, 35, 185, 187
color wheel, 94, 359
column charts, 244
columns. See table columns
defined, 415
in text boxes, 131
combining
cells in tables, 214, 216
sections, 82
commands
adding to Quick Access Toolbar, 411
adding to ribbon groups, 406
from earlier versions, 404
comment icons, 333
comments
defined, 415
adding, 332, 334
deleting, 333, 335
editing, 335
hiding, 333, 335
moving among, 333, 335
printing, 187
reviewing, 335
spoken, adding to slides, 385
Comments pane, 334
comparing versions, 336
Compatibility mode, 54
compatibility with earlier PowerPoint versions,
54, 199
Compress Pictures dialog box, 321
compressing pictures, 230, 317, 321
connecting shapes, 169
connection points, defined, 416
connectors, defined, 416
content placeholders, 140, 148, 154, 213
content templates, 46, 52
continuous
audio, 300, 302
slide shows, 179, 183
videos, 305, 310
converting
bullet points to diagrams, 154
bullet points to normal paragraphs, 104, 109, 364
bullet points to subpoints, 58
bullet points to titles, 58
presentations to .pptx format, 54
subpoints to bullet points, 58
titles to bullet points, 58
copying
animation effects, 288, 291
formatting, 163, 171
formatting to slide masters, 348
shapes, 163, 165
slides from other presentations, 69, 70, 80
text, 60
text boxes, 130
text, keyboard shortcut for, 61
copyrights, 140, 143
copyright (©) symbol, 267
correcting
mistakes automatically, 111, 113
mistakes with spelling checker, 118
pictures, 230
crash, repairing presentations after, 30
Create New Theme Colors dialog box, 357
Create New Theme Fonts dialog box, 360
cropping
pictures, 230, 232
video objects, 308
currency symbols, 267
cursor, defined, 416
custom
animation effects, 292, 295
audio content, 300, 302
presentation elements, 343
Quick Access Toolbar, resetting, 413
ribbon groups, 404, 406
ribbon, resetting, 409
ribbon tabs, 404, 407
slide layouts, 362, 363
slide shows, 376, 416
templates, 369
templates, editing, 370
theme colors/fonts, 354, 357, 360
themes, 354, 361
themes, deleting, 362
videos, 305, 307
CUSTOM.DIC dictionary, 119, 123
customizing
AutoCorrect, 111, 113
PowerPoint 2013, 391
Quick Access Toolbar, 410, 412
ribbon, 403, 404
status bar, 414
cutting text, 60
keyboard shortcut for, 61
cycle diagrams, 147
defined, 416
data
copying/pasting, 156, 157
editing in charts, 156, 159
entering in charts, 156
excluding from charts, 158
filtering in charts, 160
updating in embedded worksheets, 225
data markers in charts, 155
defined, 416
data points in charts, 155
defined, 416
data series in charts, 155
defined, 416
datasheets, adding to charts, 252
dates in footers, 179, 181
decreasing
space between characters, 106
text size, 105
default
AutoFit settings, 112
black last slide, eliminating, 37, 207
file format, 395
file save location, 395
formatting of shapes, 163
formatting of text boxes, 136
number of undo actions, 62
print settings, 185, 188
theme, 354
Define Custom Show dialog box, 376
deleting
chart templates, 254
comments, 333, 335
custom themes/colors/fonts, 362
items from Clipboard, 64
rows/columns from tables, 214
sections, 82
deleting (continued)
  shapes from diagrams, 150, 238
  slide markup, 208
  slides, 65, 67
  text, 60, 62
  transitions, 173
delivering presentations, 204, 375
  Presenter view, 189
  setting up, 178
demoting text, 58
Design tab, 22
design templates, 46, 49
defined, 416
  custom, 369
  editing, 370
destination files, defined, 416
diagram layouts, 151, 239, 241
diagram styles, 152, 241
diagrams
defined, 416
  adding alt text, 148
  adding shapes, 239
  adding text in Text pane, 149
  adding to notes, 191
  adding to slides, 148
  color, 152
  creating from bullet points, 154
  cycle, 147
  deleting shapes, 150, 238
  formatting, 152
  formatting shapes, 242
  hierarchy, 147
  moving, 148, 151
  opening Text pane, 149
  pictures of people, inserting, 241
  previewing layouts/styles, 241
  process, 147
  rearranging, 238
  relationship, 147
  restoring original, 239
  shape color, 239
  shape hierarchy, 238, 239
  shape styles, 239
  sizing, 148, 151
  switching shapes, 239
  text, formatting, 239
dialog box launchers, 13, 25
defined, 416
dialog boxes
  displaying, 13
  moving, 127
dictionaries
  in English version of PowerPoint, 119
  supplemental, 119, 123
  supplemental, removing entries, 124
digital signatures, 330
dimming after animation, 294
direction of text, 133
Display control panel item, 19
displaying full-screen slides, 204
distributing graphics, 256, 257
dividing
  presentations into sections, 76
  table cells, 214
Document Inspector, 198
defined, 416
Document Panel, 198
drag-and-drop editing, 60
dragging objects, defined, 416
drawing
  action buttons, 283
  shapes, 162, 163
  table cells, 214
duplicating
  ribbon groups, 404
  shapes, 163, 166
  slides, 69, 72
duration
  specifying for animation, 292, 297
  specifying for transitions, 175
E
editing
  comments, 335
  custom slide shows, 378
  data in charts, 156, 159
  enabling in Protected view, 21
  headers/footers before printing, 187
  photo albums, 234
  pictures, 229, 230
  redoing, 62, 65
  reversing, 62, 65
  templates, 370
text, 60
text in text boxes, 130
text, keyboard shortcuts for, 61
undoing, 62, 65
Effect Options gallery, 295
effects. See also animation effects; font effects; theme effects
applying to placeholders, 100
applying to shapes, 163, 167
applying to text, 131
applying to text boxes, 131
artistic, for pictures, 230, 236
email messages
attaching presentations, 326
starting with hyperlinks, 276, 277
embedded objects, defined, 416
embedded worksheets
formatting, 226
sizing/moving/aligning, 224
updating, 225
embedding
fonts, 388, 395
vs. linking objects, 221
videos from websites, 304
worksheets, 221, 222
Emphasis animation effects, 292
enabling editing in Protected view, 21
encrypting
defined, 416
presentations, 330
ending presentations, 205
enhanced handouts, 196
enlarging shapes, 242
entering
symbols/equations, 267, 270
text in Outline pane, 57
text in placeholders, 56
text in tables, 214, 216
text in text boxes, 130
Entrance animation effects, 288
Equation gallery, 269
equations
display options, 273
inserting, 268, 271
erasing
slide markup, 208
table cell borders, 214
errors, correcting, 111, 118
Excel worksheets. See worksheets
Exciting animation effects, 292
excluding data from charts, 158
Exit animation effects, 292
expanding outlines, 62
exporting animation effects, 292
exporting presentations as outlines, 68
Export page (Backstage), 196
extensions, file name, 52
Eyedropper, 95, 248
faxing presentations, 327
file formats
defined, 416
default, 395
saving presentations, 316
file name extensions, 52
defined, 416
file save location, default, 395
file size, minimizing, 230
File tab, 26
files
audio, 299
opening with hyperlinks, 276, 278
types of, 52
video, 304, 305
filtering data in charts, 160
finalizing presentations, 199, 203
finding
capitalization, 126
text, 126
First Line Indent marker, 346
defined, 416
fitting slides to page when printing, 187
flipping shapes, 165
followed hyperlink theme color, 353
font effects, defined, 417
fonts. See also theme fonts
defined, 416
changing, 105
embedding in presentation files, 388, 395
replacing, 126, 128
Fonts gallery, 356
font size, defined, 417
font styles, defined, 417
footers, 179, 181
defined, 417
adding to notes pages, 193
editing before printing, 187
excluding from title slide, 182
removing from slide masters, 352
Format Background pane, 87
Format Painter, 163, 171, 348
Format Shape pane, 130
Format tool tab, 25
Format Video pane, 308
formatting
bullet points on slide masters, 346, 349
bullet styles, 104
characters, 105, 107
chart elements, 245
charts, 244
clearing, 106, 109
copying, 163, 171
copying to slide masters, 348
diagrams, 152
diagram shapes, 239, 242
diagram text, 239
embedded worksheets, 226
lists, 104
number styles, 104
paragraphs, 104, 109
placeholders, 96
plot area, 248
removing local, 361
retaining for reused slides, 72
shapes, 96, 163
shapes, default, 163
slide masters, 347
table cells, 218, 220
tables, 218
text boxes, default, 136
WordArt text, 264, 266
Fraction gallery, 272
fractions, inserting, 272
frames around slides, printing, 186
French dictionary, 119
Full Screen mode, 11

galleries, 14
defined, 417
closing, 23
displaying, 23
sizing, 219, 288
General Options dialog box, 331
getting help, 40
.gif format, 146
Gradient gallery, 99
graphic formats
BMP (bitmap), 146
GIF, 146
JPEG, 146
PNG, 146
TIFF, 146
graphic icons, 267, 270
graphics, 139. See also pictures; shapes
defined, 417
adding annotations, 129, 143
aligning/distributing, 256, 257
alt text, 238
arranging, 255
attaching hyperlinks, 277, 278, 279
background, hiding, 91
screen clippings, 274
selecting hidden, 256, 257
stacking order, 256, 257, 347
gray scale, defined, 417
gray scale slides, 185, 187
Grid And Guides dialog box, 25, 259
gridlines, 258
displaying, 35
removing from charts, 249
grouping
defined, 417
pictures, 256
shapes, 163, 170
groups, ribbon, 13
defined, 417
custom, 404, 406
duplicating, 404
hiding/displaying, 21, 35
moving, 404
removing from tabs, 404, 405
guides, 258
handles, *defined*, 417
Handout Master view, 35
  *defined*, 417
handout masters, 190, 344
  *defined*, 417
handouts, 189
  creating in Word, 196
  enhanced, 196
  layout, 190
  printing, 186, 194
Hanging Indent marker, 346
  *defined*, 417
Header And Footer dialog box, 181, 193
headers
  adding to notes pages, 193
  editing before printing, 187
heading font in theme fonts, 354
  *defined*, 417
Help window, 41
  printing, 42
help with PowerPoint, 11, 40
hidden
  graphics, selecting, 256, 257
  slide content, 199
  slides, 376
  slides, displaying, 380
hiding
  audio icons, 300
  bullet points in Outline pane, 62
  comments, 333, 335
  data in charts, 158
  Mini Toolbar, 393
  objects, 60, 256
  objects after animation, 294
  panes in Normal view, 35, 37
  ribbon, 412
  ribbon groups, 21
  ScreenTips, 393
  sections, 80
  slide content, 199
  slides, 376, 379
  video objects, 305
hierarchy diagrams, 147
  *defined*, 417
hierarchy of diagram shapes, 238, 239
highlighting slides during presentations, 206, 207
Home tab, 13, 21
Hyperlink To Slide dialog box, 282
hyperlinks, 276
  adding to every slide, 280
  specifying ScreenTips, 279
  theme color, 353
Hypertext Markup Language (HTML), *defined*, 417
icons, *defined*, 417
importing outlines, 69
increasing
  space between characters, 106
  text size, 105, 108
indentation of bullet points, 351
Indent marker, *defined*, 417
Info page (Backstage), 198, 199
information, removing from presentations, 197, 201
Information Rights Management, 330
Insert Chart dialog box, 157
Insert Hyperlink dialog box, 277, 278
inserting. See also adding; entering
  fractions, 272
  line breaks, 106, 110
  symbols/equations, 267, 270
Insert Object dialog box, 222
Insert Outline dialog box, 69
Insert Picture dialog box, 141
Insert Pictures dialog box, 350
Insert Pictures pane, 144
Insert tab, 22
Insert Table dialog box, 215
installing add-ins, 402
invisible content, 199
italic text, 105, 107
.jpeg format, 146
jumping
  with actions, 281
  with hyperlinks, 276, 279
keyboard shortcuts
  defined, 417
  displaying, 22
  for editing text, 61
  for navigating slides, 205
  for Office, listed, 431
  for symbols, 268
kiosk mode, defined, 417

Language dialog box, 121
languages, specifying, 396
laser pointer, 206, 207
layouts. See slide layouts; diagram layouts
Left Indent marker, 346
  defined, 418
legacy commands, 404
legends in charts, 155, 250
  defined, 418
length
  of animation, specifying, 292, 297
  of transitions, specifying, 175
letter-by-letter animation, 294, 297
libraries. See slide libraries
line breaks, 106, 110
  defined, 418
line graphs, 244
line spacing, 105, 109
lining up slide elements, 35
linked objects, defined, 418
linked vs. embedded objects, 221
linking pictures for automatic updating, 141
lists, formatting, 104
Live Preview, 15, 23
  defined, 418
  disabling, 393
local formatting, removing, 361
looping
  audio content, 300, 302
  slide shows, 179, 183
  videos, 305, 310
magnification
  of screen, 19
  of slides, 14, 35, 39
  of slides, in print preview, 188
  of slides, in Slide Sorter view, 81
margins of text boxes, 131
marking
  non-English words/phrases, 119, 121
  presentations as final, 199, 203
  slides during presentations, 206, 207
masters, defined, 418. See also slide masters; handout masters; notes masters
mathematical symbols, 268
media, compressing, 317, 321
merging
  cells in tables, 214, 216
  presentations, 336
Microsoft Office Clipboard. See Clipboard
minimizing program window, 11
Mini Toolbar, 106, 107
  defined, 418
  hiding, 393
Mini Translator, 125
mistakes
  correcting automatically, 111, 113
  correcting with spelling checker, 118
Moderate animation effects, 292
monitors, multiple, 204
Motion Path animation effects, 292
moving
  among comments, 333, 335
  among table cells, 214
  audio icons, 301
  charts, 156
  diagrams, 148, 151
  dialog boxes, 127
  embedded objects, 224
  pictures, 142, 232
  placeholders, 96
Quick Access Toolbar below ribbon, 410
ribbon groups, 404
sections, 82
shapes, 163
shapes in diagrams, 238
objects

defined, 418
attaching hyperlinks, 277
changing order, 256
embedded vs. linked, 221
embedded worksheets, 221
formatting, 226
hiding on slides, 256
sizing/moving/aligning, 224
updating, 225

Office 365, 4
Office 2013 RT, 4
off-slide content, 199
OneNote notes, 197
Open dialog box, 31
Open page (Backstage), 28
opening
files with hyperlinks, 276, 278
outlines as presentations, 70
presentations, 28, 30
presentations from File Explorer, 21
Text pane (diagrams), 149

Options dialog box, 324
order
of graphics, 256, 257, 347
of objects, 256
of slides, 80
orientation
of slides, 181
of text boxes, 130, 131

Outline pane, 57
defined, 418

Outline view, 15, 33, 36
defined, 418

outlines. See also borders
expanding/collapsing, 62
exporting presentations as, 68
importing, 69
opening as presentations, 70
printing, 186
viewing, 36

overhead projectors, 178, 179
Package for CD, defined, 418
Package For CD dialog box, 387
packaging presentations, 386, 387
palettes, defined, 418
panes
    adjusting size, 190
    hiding, 35, 37
    sizing, 35, 37
Paragraph dialog box, 109
paragraph formatting, 104, 109
    defined, 418
paragraphs. See text
paragraph spacing, 105, 109
Password dialog box, 331
passwords
    defined, 418
    assigning, 330
    removing, 332
pasting
    cut/copied items from Clipboard, 64
text, 61
text, keyboard shortcut for, 61
paths, defined, 418
pausing
    audio, 303
    presentations, 206, 381
.pdf format, 318
pen, 206, 207
color, 209
Photo Album dialog box, 231
photo albums, 230, 231
    defined, 419
captions, 234
editing, 234
    using layouts in any presentation, 230, 237
picture bullets, 349
picture diagrams, 419
pictures, 140
    defined, 419
    adding alt text, 144
    adding to notes, 190
    adding to slides, 140, 141
    adding to slides without content placeholders, 143
    aligning while sizing, 233
    animating, 290
artistic effects, 230, 236
background, removing, 230, 234
borders, 230
color, 230
compressing, 230, 317, 321
correcting, 230
cropping, 230, 232
editing, 229, 230
grouping, 256
linking for automatic updating, 141
moving, 142, 232
of people, inserting in diagrams, 241
rotating, 230
shadows/reflections, 230
sizing, 142, 232
as slide backgrounds, 88
stored on SkyDrive, 141
transparent color, 230
pie charts, 244
pinning/unpinning ribbon, 35
pixels, defined, 419
Placeholder gallery, 363
placeholders, 129
    defined, 419
    adding to slide layouts, 363
    AutoFit settings, 112
    borders, 99
    content, 140, 148, 154, 213
effects, 100
    entering text, 56
    filling with color, 98
    formatting, 96
    selecting all text in, 108
    selecting for editing, 97
    selecting for manipulation, 97
    sizing/moving, 96
    sizing to fit text, 105
    on slide masters, 344
playing
    audio content, 299, 302
    audio content across slides, 303
    sounds with actions, 281, 283
    videos, 306
plot area, chart
    defined, 419
    formatting, 248
plotting charts by rows/columns, 159
.png format, 146
pointing to slide elements during delivery, 206, 207
points (pt), 99
Portable Document Format (PDF), 318
positioning
slide elements, 35. See also moving text boxes, 131
PowerPoint 2013
closing, 11
compatibility with earlier versions, 54
customizing, 391
desktop installation, 4
getting help, 40
starting, 10
PowerPoint 2013 Mobile, 340
PowerPoint 2013 Web App, 340
defined, 419
PowerPoint Help window, 41
PowerPoint icon, 11
PowerPoint Options dialog box, 27
Add-Ins page, 399
Advanced page, 397
Customize Ribbon page, 403
General page, 392
Language page, 396
Proofing page, 394
Quick Access Toolbar page, 410
Save page, 395
Trust Center page, 400
PowerPoint Picture Presentations, 316, 320
PowerPoint Shows, 316, 319
PowerPoint Viewer, 386
defined, 418
PowerPoint Web App. See PowerPoint 2013 Web App
.ppsx format, 316
.ppt format, 54, 316
.pptx format, 52, 54, 316
converting presentations to, 54
presentations
accepting/rejecting revisions, 338
adapting to audience, 376
adding transitions, 171, 172
assigning passwords, 330
autosaving, 49, 395
basing on custom templates, 369, 371
blank, 46, 49
checking spelling, 119, 121
closing, 30, 32
collaborating, 340
comparing, 336
compatibility with earlier versions, 54
converting to .pptx format, 54
copying slides between, 80
custom elements, 343
default file location, 395
default format, 395
delivering, 204, 375
delivering in Presenter view, 189
digital signatures, 330
displaying all slides, 81
dividing into sections, 76
embedding fonts, 388
encrypting with passwords, 330
ending, 205
exporting as outlines, 68
faxing, 327
handouts, 189
jumping to with hyperlinks, 276
looping, 179, 183
marking as final, 199, 203
marking slides, 206, 207
merging, 336
minimizing file size, 230
moving to first slide, 121
moving to last slide, 141
navigating, 30, 31, 205, 206
opening, 28, 30
opening from File Explorer, 21
opening options, 30
opening outlines as, 70
packaging, 386, 387
passwords, 330
pausing, 206, 381
photo albums, 231
presenting online, 329
previewing for typographical errors, 184
previewing in Reading view, 34
properties, 198, 199, 200
read-only, 330
rearranging, 80
recording, 384
rehearsing, 381, 382
removing personal/confidential information, 197, 201
restricting access, 330
presentations (continued)
  reviewing, 332, 340
  running automatically, 179, 183
  saving, 46, 53
  saving as PowerPoint Picture Presentations, 320
  saving as PowerPoint Shows, 319
  saving as .rtf files, 68
  saving as templates, 369, 370
  saving as videos, 317, 321
  saving in new folder, 48, 54
  saving in other formats, 316
  saving in .ppt format, 54
  saving in .xps format, 323
  sending link via email, 327
  sending via email, 326
  setting up for delivery, 178
  sharing, 340
  sound tracks, 303
  spoken comments, 385
  starting, 46, 206
  stopping, 207
  switching among, 38, 86
  viewing, 33
  viewing all open, 38
  for webpage banners, 179, 181
Presenter view, 189, 204
defined, 419
presenting online, 329
previewing
  animation effects, 290
  artistic effects, 236
  custom slide shows, 377
  cut/copied items before pasting, 61
  diagram layouts/styles, 241
  presentations for typographical errors, 184
  presentations in Reading view, 34
  themes, 23, 84, 85
  transitions, 172, 174, 175
primary master, 344
Print page (Backstage), 184, 187
printing
  comments, 187
  default settings, 185, 188
  frames around slides, 186
  handouts, 194
  Help topics, 42
  notes, 194
slide markup, 187
slides, 184
slide sizes for, 179
process diagrams, 147
defined, 419
program icon, 11
program window, sizing, 17
programs, starting with actions, 281
promoting text, 57, 58, 59
properties
defined, 419
  changing, 200
  removing, 201
  viewing, 198, 199
Properties dialog box, 201
Protected view, 21, 30
Quick Access Toolbar, 11
defined, 419
  for active presentation, 412
  adding separators, 412
  customizing, 410, 412
  customizing for efficiency, 11
  moving below ribbon, 410
  resetting, 413
Quick Layout gallery, 251
read-only presentations, 30, 330
defined, 419
  final, 199, 203
Reading view, 15, 34, 37
defined, 419
  previewing transitions, 174
rearranging
diagrams, 238
presentations, 80
recording presentations, 384
redoing editing, 62, 65
  keyboard shortcut for, 61
red wavy underlines, 119, 120
reflections, 230
registered trademark (®) symbol, 267
regrouping shapes, 163
rehearsing presentations, 381, 382
rejecting revisions, 337, 338
relationship diagrams, 147
defined, 419
removing
bullet characters, 364
chart gridlines, 249
entries from supplemental dictionary, 124
local formatting, 361
passwords, 332
personal/confidential information, 197, 201
picture backgrounds, 230, 234
ribbon groups from tabs, 404, 405
ribbon tabs, 404, 405
slide markup, 208
transitions, 174
Rename Layout dialog box, 367
Rename Section dialog box, 78
renaming
ribbon tabs, 408
sections, 78
slide layouts, 367
repairing presentations while opening, 30
Replace dialog box, 126
Replace Font dialog box, 128
replacing
fonts, 126, 128
text, 60, 62, 126
researching information, 125
restoring diagrams, 239
restricting presentation access, 330
retaining formatting for reused slides, 72
Reuse Slides pane, 70
reusing slides, 69, 70, 237
reversing editing, 62, 65
reviewing
comments, 335
presentations, 332, 340
Review tab, 24
revision icons, 337
revisions, accepting/rejecting, 337, 338
Revisions pane, 337
ribbon, 11
defined, 419
appearance, 16
buttons, 13
collapsing, 35
customizing, 403, 404
groups, 13
groups, custom, 404, 406
groups, duplicating, 404
groups, hiding/displaying, 21, 35
groups, moving, 404
groups, removing from tabs, 404, 405
hiding, 412
legacy commands, 404
pinning/unpinning, 21
resetting, 409
tabs, 12
tabs, custom, 404, 407
tabs, removing, 404, 405
tabs, renaming, 408
tool tabs, 13, 25
Rich Text Format (RTF), 68, 69
defined, 419
rotating
pictures, 230
shapes, 162, 165, 260
text, 133
text boxes, 130, 131
rotating handles, defined, 419
rows. See table rows
 rtformat
outlines, importing, 69
saving presentations in, 68
rulers, turning on/off, 35, 135, 142
running presentations automatically, 179, 183
S
Save As dialog box, 48
displaying Navigation pane, 51
Save As page (Backstage), 47
saving
charts as templates, 245, 253
PowerPoint Picture Presentations, 320
PowerPoint Shows, 319
saving (continued)

presentations, 46, 53
presentations as .rtf files, 68
presentations as videos, 317, 321
presentations in new folder, 48, 54
presentations in other formats, 316
presentations in .ppt format, 54
to SkyDrive, 55
slides as picture files, 141
slides in .xps format, 323
templates, 369, 370
themes, 361
videos, 317, 321

scaling slides when printing, 187
screen clippings, 274
defined, 420
screen magnification, 19
screen resolution, 18
Screen Resolution control panel item, 18
ScreenTips, 13, 22
defined, 420
hiding, 393
language, 396
specifying for hyperlinks, 279

searching for text, 126
sections
applying themes, 86
combining, 82
deleting, 82
dividing presentations into, 76
hiding/unhiding, 80
moving, 82
renaming, 78
selecting all slides in, 79
security settings, 400

selecting
defined, 420
all slides in section, 79
all text in placeholder, 108
cells in worksheets, 156
chart elements, 245, 249
graphics, hidden, 256, 257
placeholders for editing, 96, 97
placeholders for manipulation, 96, 97
series of slides, 65
shapes, 162
table cells, 220
tables, 220
text, 60
text boxes for editing, 130
text boxes for manipulation, 130
Selection pane, 60, 199, 256, 257
Send To Microsoft Word dialog box, 196
sentences. See text
separators on Quick Access Toolbar, 412
series axes in charts, 155
defined, 420
series of slides, selecting, 65
Set Hyperlink ScreenTip dialog box, 279
Set Up Show dialog box, 183, 378
setting up presentations for delivery, 178
shading
table cells, 220
worksheet cells, 226
shadow effects, 105, 230

shapes
defined, 420
adding effects, 163, 167
adding text, 163, 166
adding to diagrams, 239
adjusting, 162
attaching hyperlinks, 277
borders, 99, 163
color, 163
connecting, 169
copying, 163, 165
copying formatting, 163, 171
default formatting, 163
deleting from diagrams, 150, 238
drawing, 162, 163
duplicating, 163, 166
effects, 100
enlarging, 242
filling with color, 98
flipping, 165
formatting, 96, 163
formatting in diagrams, 239, 242
grouping/ungrouping/regrouping, 163, 170, 171
moving, 163
rearranging in diagrams, 238
rotating, 162, 165, 260
sizing, 162, 163, 166
switching in diagrams, 239
switching to different, 168
Shapes gallery, 163
Shape Style gallery, 98
shape styles, in diagrams, 239
Share page (Backstage), 326
SharePoint
  collaborating on presentations, 340
  saving presentations to, 47
sharing
  presentations, 340
  presentations in other formats, 316
shortcuts, displaying, 22
shrinking text to fit text box, 131
sigma (Σ) symbol, 268
single-line text boxes, 129, 131
sizing
  charts, 156, 159
  diagrams, 148, 151
  embedded objects, 224
  galleries, 219, 288
  panes in Normal view, 35, 37, 190
  pictures, 142, 232
  placeholders, 96
  placeholders to fit text, 105
  program window, 11, 17
  ribbon, 17
  shapes, 162, 163, 166
  text, 105, 108
  text boxes, 130, 131
  video objects, 308
sizing handles, *defined*, 420
SkyDrive, 340
  inserting pictures from, 141
  saving files to, 55
slide backgrounds, 87, 89
slide layouts
  adding placeholders, 363
  custom, 362, 363
  default, 66
  master, 344
  non-default, 66
  photo album, using in any presentation, 230, 237
  renaming, 367
  selecting when adding slide, 65
  switching for existing slide, 65, 68
slide libraries, 71
  *defined*, 420
slide markup, 206, 207
  erasing, 208
  printing, 187
Slide Master view, 35, 344, 347
  *defined*, 420
slide masters, 344
  *defined*, 420
  adding hyperlinks, 280
  bullet points, 346, 349, 351
  custom layouts, 363
  footers, removing, 352
  formatting, 347
  primary master, 344
  viewing, 347
slide numbers in footers, 179, 181
Slide pane, 16
  *defined*, 420
slide shows
  custom, 376
  looping, 179, 183
  running automatically, 179, 183
Slide Show tab, 24
Slide Show view, 15, 36, 206
  *defined*, 420
slide size, 178, 180
Slide Size dialog box, 180
Slide Sorter view, 15, 33, 37, 175
  *defined*, 420
  zooming in/out, 81
slide timings, 380
  *defined*, 420
  applying to all slides, 382
  applying to selected slide, 381
  deleting all, 382
  rehearsing, 382
slides
  adding audio content, 299
  adding charts, 154, 157
  adding clip art images, 140, 144
  adding comments, 332, 334
  adding diagrams, 148
  adding footers, 179, 181
  adding notes, 189, 190
  adding pictures, 140, 141
  adding pictures, without content
    placeholders, 143
  adding to presentations, 65, 66
  adding videos, 303
  adding WordArt text, 264
  background, 87, 89
  background, hiding, 91
slides (continued)

  building with animation, 292
  copying between presentations, 80
  copying from other presentations, 69, 70
  deleting, 65, 67
  displaying all, 81
  displaying full screen, 204
  duplicating, 69, 72
  entering text, 56
  fitting to Slide pane, 40
  hiding/unhiding, 80, 376, 379
  highlighting, 206, 207
  importing outlines, 69
  jumping to with actions, 281
  jumping to with hyperlinks, 276
  moving, 81
  moving among, 30, 31, 205, 206
  object order, 256
  order, 80
  orientation, 181
  pointing to elements, 206, 207
  printing, 179, 184
  retaining formatting when reusing, 72
  reusing, 69, 70, 237
  saving as pictures, 141
  saving in .xps format, 323
  scaling when printing, 187
  selecting all in section, 79
  selecting series, 65
  size, 178, 180
  in slide libraries, 71
  switching layout, 65, 68
  viewing color in black and white, 35, 185, 187
  watermarks, 93
  zooming during delivery, 206
  zooming in Normal view, 14, 35, 39
  zooming in print preview, 188
  zooming in Slide Sorter view, 81

smart guides, 142
  defined, 420

SmartArt Graphics, 147. See also diagrams
  defined, 420

SmartArt Styles gallery, 152

snapping to grid, 260

sounds. See also audio content
  adding to animation effects, 294, 297
  adding to transitions, 175
  playing with actions, 281, 283

sound tracks, 303

source files, defined, 420

source programs, defined, 420

spacing
  character, 106
  line, 105, 109
  paragraph, 105, 109

Spanish dictionary, 119

speaker notes
  adding to slides, 189, 190
  with graphics, 34, 190
  headers/footers, 193
  printing, 186, 194

spelling
  correcting automatically, 111
  correcting entire presentation, 118

spelling checker, 118
  options, setting, 394
  turning off, 119

Spelling pane, 121

splitting table cells, 214
  defined, 420

spoken comments, adding to slides, 385

spotlighting slide elements, 206

squares, drawing, 162

stacked objects, defined, 420

stacking order of graphics, 256, 257, 347

starting
  email messages with hyperlinks, 276, 277
  PowerPoint from File Explorer, 21
  presentations, 46, 206
  programs with actions, 281
  videos automatically, 310

status bar, 14
  defined, 420
  customizing, 414

stopping presentations, 207

strikethrough effects, 105

style
  of diagrams, 152, 241
  of video objects , 308

subpoints, 56
  defined, 420
  converting to bullet points, 58
  converting to titles, 59

Subtle animation effects, 292
suffixes, file. See file name extensions
summation (∑) symbol, 268
supplemental dictionaries, 119, 123
removing entries, 124
Symbol dialog box, 268, 270
symbols
inscribing, 267, 270
keyboard shortcuts for, 268
synonyms, 119, 123

table cells
aligning text, 217
drawing, 214
formatting, 218, 220
merging, 214, 216
moving among, 214
selecting, 220
shading, 220
splitting, 214
table columns, adding/deleting, 214
table rows
adding/deleting, 214, 216
banded, 218
table structure, 214
table styles, 218, 220
Table Styles gallery, 219
tables, 213
defined, 420
adding borders, 220
adding to slides, 213, 215
attaching hyperlinks, 277
creating from Word tables, 214
drawing cells, 214
entering text, 214, 216
erasing cell borders, 214
formatting, 218
merging cells, 214, 216
moving, 217
selecting, 220
splitting cells, 214
tabs, ribbon, 12
defined, 420
Animations, 24
custom, 404, 407
Design, 22
File, 26
Home, 13, 21
Insert, 22
removing, 404, 405
renaming, 408
Review, 24
Slide Show, 24
tool, 13, 25
Transitions, 23
View, 25
templates
defined, 421
chart, deleting, 254
chart, saving, 245, 253
content, 46, 52
design, 46, 49
editing, 370
saving, 369, 370
testing
sounds, 300
videos, 305
text
adding to diagrams, 149
adding to shapes, 163, 166
aligning in placeholders, 104, 109
aligning in table cells, 217
aligning in text boxes, 131
applying attributes, 105, 107
attaching hyperlinks, 277
automatically sizing to fit placeholder, 112, 116
capitalization, 106
color, 105, 108, 131
copying, 60
cutting, 60
deleting, 60, 62
direction, 130, 131, 133
editing, 60
editing, keyboard shortcuts for, 61
effects, applying, 131
entering/editing in text boxes, 130
entering in Outline pane, 57
entering in placeholders, 56
entering in tables, 214, 216
finding, 126
font, 105
formatting in diagrams, 239
text (continued)
 moving, 60, 63
 outlines around, 131
 outside of placeholders, 129
 pasting, 61
 previewing for typographical errors, 184
 promoting/demoting, 57, 58, 59
 replacing, 60, 62, 126
 rotating, 133
 selecting, 60
 selecting all in placeholder, 108
 shrinking to fit text box, 131
 sizing, 105, 108
 sizing placeholders to fit, 105
 theme colors, 353
 translating, 125
 underlining, 105
 WordArt. See WordArt text
 WordArt Styles, 264

 text boxes, 129
 defined, 421
 adding to slides, 129, 131, 135, 144
 alt text, 131
 borders, 99, 131, 134
 color, 131
 copying, 130
 default formatting, 136
 effects, 100, 131
 entering/editing text, 130
 filling with color, 98
 manipulating, 130
 margins, 131
 moving, 130, 133
 multi-line, 129, 135
 multiple columns, 131
 positioning, 131
 rotating, 130, 131
 single-line, 129, 131
 sizing, 130, 131
 wrapping text, 131

 Text pane (diagrams), opening, 149
 textured backgrounds, 88, 91
 theme colors, 353
 defined, 421
 custom, creating, 354, 357
 custom, deleting, 362
 switching sets, 353, 355

 theme effects, 354
 theme fonts
 defined, 421
 custom, creating, 354, 357, 360
 custom, deleting, 362
 switching sets, 353, 356

 themes, 84
 defined, 421
 applying to sections, 86
 custom, creating, 354
 custom, deleting, 362
 custom, saving, 361
 live previews of, 85
 previewing, 23
 setting default, 354
 switching, 84
 variants, 84, 86

 Themes gallery, 23, 84

 Thesaurus, 119, 123
 defined, 421

 Thesaurus pane, 123
 thumbnails, defined, 421
 Thumbnails pane, 16
 defined, 421

 tick-mark labels in charts, 155
 defined, 421

 .tiff format, 146

 time in footers, 179, 181

 timings, slide, 380
 applying to all slides, 382
 applying to selected slide, 381

 title bar, 11
 defined, 421

 titles
 animating, 288
 converting to bullet points, 58

 title slides defined, 421

tool tabs, defined, 421

 transitions
 defined, 421
 adding sounds/duration, 175
 adding to slides, 171, 172
 previewing, 172, 174, 175
 removing, 174

 Transitions tab, 23
translating text, 125
transparencies, 178, 179
transparent color in pictures, 230
trimming
  audio content, 300
  videos, 305, 307
Trim Video dialog box, 307
Trust Center, 400
Trust Center dialog box, 401
trusted locations, 400
two monitors, 204

underlining text, 105
undo actions, default number, 62
undoing editing, 62, 65
  keyboard shortcut for, 61
ungrouping shapes, 163, 171
unhiding sections, 80
updating
  embedded worksheets, 225
  pictures, automatically, 141
upgrading
  from PowerPoint 2003, 9
  from PowerPoint 2007, 7
  from PowerPoint 2010, 6
user interface
  background, 393
  language, 396
user name/initiials, 393

value axes in charts, 155
  defined, 421
variants of themes, 84, 86
video clips, 304
video files, 304, 305
video objects, 304
  cropping, 308
  hiding, 305
  sizing, 308
video styles, 308
Video Styles gallery, 309
videos
  adding to slides, 303
  customizing, 305, 307
  from websites, 304
  looping, 305, 310
  playing, 306
  saving presentations as, 317, 321
  sound volume, 305, 310
  starting automatically, 310
  testing, 305
  trimming, 305, 307
viewing
  all open presentations, 38
  Clipboard, 64
  presentations, 33
  properties, 198, 199
  slide masters, 347
views, 15
  Backstage, 12
  Handout Master, 35
  Normal, 15, 33, 37
  Notes Master, 35
  Notes Page, 34, 189, 190
  Outline, 15, 33, 36
  Presenter, 189, 204
  Protected, 21, 30
  Reading, 15, 34, 37, 174
  Slide Master, 35, 344, 347
  Slide Show, 15, 36, 206
  Slide Sorter, 15, 33, 37, 175
  switching among, 34
View Shortcuts toolbar, 14
  defined, 421
View tab, 25
volume
  of audio content, 300
  of video sound, 305, 310

watermarks
  defined, 421
  adding to slides, 93
wavy underlines, 119, 120
Web App, 5, 340
web browsers
defined, 421
opening presentations in, 30
webpage banners, 179, 181
webpages, defined, 421
websites
jumping to with hyperlinks, 276, 279
videos from, 304
white pause screen, 206
windows, arranging, 35, 38
Wingdings font, 270
WordArt gallery, 264
WordArt objects, defined, 421
WordArt styles, 266
applying to regular text, 264
WordArt text, 264, 266
word-by-word animation, 294
Word handouts, 196
Word outlines, importing, 69
Word tables, copying/pasting 214
worksheets
associated with charts, 154
copying/pasting existing data, 156, 157
embedding, 221, 222
entering data, 156
formatting, 226
selecting cells, 156

X
x-axes in charts, 155
defined, 421
.xml format, 54
.xps format, 318
saving slides in, 323

Y
y-axes in charts, 155
defined, 421

Z
z-axes in charts, 155
defined, 421
Zoom dialog box, 39
zooming in/out, 14, 35, 39
during delivery, 206
in print preview, 188
in Slide Sorter view, 81